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Arduino
https://store.arduino.cc/

• 80€ (Arduino store)


• Manuale in italiano (inglese, spagnolo, francese, tedesco, cinese, coreano, arabo)


• Non disponibile per il download, ma sono presenti i video tutorial  
e il codice dei singoli progetti  
https://www.youtube.com/playlist?list=PLT6rF_I5kknPf2qlVFlvH47qHvqvzkknd

https://www.youtube.com/playlist?list=PLT6rF_I5kknPf2qlVFlvH47qHvqvzkknd


+ - + -

+ -+ -

BUILD THE
CIRCUIT

Fig.  2

Fig.  3

In this project, you need to check the ambient temperature of the room before 

proceeding. You’re checking things manually right now, but this can also be accom-

plished through calibration. It’s possible to use a bu!on to set the baseline tempera-

ture, or to have the Arduino take a sample before starting the loop() and use that 

as the reference point. Project 6 gets into details about this, or you can look at the 

Calibration example that comes bundled with the Arduino so"ware: 

arduino.cc/calibration
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Love-o-Meter
Project 03

Just as you’ve been doing in the earlier projects, wire up your 

breadboard so you have power and ground. 

A!ach the cathode (short leg) of each of the LEDs you’re using to 

ground through a 220-ohm resistor. Connect the anodes of the 

LEDs to pins 2 through 4. These will be the indicators for the project.

Place the TMP36 on the breadboard with the rounded part fac-

ing away from the Arduino (the order of the pins is important!) 

as shown in Fig. 2. Connect the le" pin of the flat facing side to 

power, and the right pin to ground. Connect the center pin to pin 

A0 on your Arduino. This is analog input pin 0.

Create an interface for your sensor for people interact with. A paper cutout in the 

shape of a hand is a good indicator. If you’re feeling lucky, create a set of lips for 

someone to kiss, see how well that lights things up! You might also want to label 

the LEDs to give them some meaning. Maybe one LED means you’re a cold fish, 

two LEDs means you’re warm and friendly, and three LEDs means you’re too hot 

to handle!

❶

❷

❸

❶

Cut out a piece of paper that will fit over the breadboard. 
Draw a set of lips where the sensor will be, and cut some 
circles for the LEDs to pass through.

❷

Place the cutout over the breadboard so that the lips cover 
the sensor and the LEDs fit into the holes. Press the lips to 
see how hot you are!
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Constants are similar to variables in that they allow you to 

uniquely name things in the program, but unlike variables they 

cannot change. Name the analog input for easy reference, and 

create another named constant to hold the baseline temperature. 

For every 2 degrees above this baseline, an LED will turn on.

You’ve already seen the int datatype, used here to identify which 

pin the sensor is on. The temperature is being stored as a float, or 

floating-point number. This type of number has a decimal point, 

and is used for numbers that can be expressed as fractions.

In the setup you’re going to use a new command, Serial.

begin(). This opens up a connection between the Arduino and 

the computer, so you can see the values from the analog input 

on your computer screen.

The argument 9600 is the speed at which the Arduino will 

communicate, 9600 bits per second. You will use the Arduino 

IDE’s serial monitor to view the information you choose to 

send from your microcontroller. When you open the IDE’s serial 

monitor verify that the baud rate is 9600.

Next up is a for() loop to set some pins as outputs. These are 

the pins that you a!ached LEDs to earlier. Instead of giving them 

unique names and typing out the pinMode() function for each 

one, you can use a for() loop to go through them all quickly. 

This is a handy trick if you have a large number of similar things 

you wish to iterate through in a program. Tell the for() loop to 

run through pins 2 to 4 sequentially.

In the loop(), you’ll use a local variable named sensorVal 

to store the reading from your sensor. To get the value from 

the sensor, you call analogRead() that takes one argument: 

what pin it should take a voltage reading on. The value, which is 

between 0 and 1023, is a representation of the voltage on the pin.

The function Serial.print() sends information from the 

Arduino to a connected computer. You can see this information 

in your serial monitor. If you give Serial.print() an 

argument in quotation marks, it will print out the text you typed. 

If you give it a variable as an argument, it will print out the value 

of that variable.

THE CODE

A pair  of  useful  constants

Init ia l ize the ser ia l  port  to 
the desired speed

Initialize the digital pin 
directions and turn off

Read the temperature sensor

Send the temperature sensor 
values to the computer
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Love-o-Meter
Project 03

1

2

3

4

5

6

7

8

9 

const int sensorPin = A0;

const float baselineTemp = 20.0;

void setup(){

  Serial.begin(9600); // open a serial port

 

  for(int pinNumber = 2; pinNumber<5; pinNumber++){

    pinMode(pinNumber,OUTPUT);

    digitalWrite(pinNumber, LOW);

  } 

}

void loop(){

  int sensorVal = analogRead(sensorPin);

  Serial.print(“Sensor Value: “); 

  Serial.print(sensorVal);

10

11

12

13

for() loop tutorial

arduino.cc/for
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✴Applicazioni pratiche dei singoli progetti 

✴Materiale aggiuntivo (cartoncini) per rendere i 

progetti più interattivi

✴Componenti di qualità

✴Manuale stampato (seppur di difficile lettura)

✴Codice ampiamente commentato

✴Libro resta difficilmente aperto, rende difficoltoso 

montaggio del progetto



37€ (Amazon) 


Manuale in italiano (inglese, spagnolo, francese, tedesco, giapponese)


https://www.elegoo.com/blogs/arduino-projects/elegoo-uno-r3-project-the-most-complete-
starter-kit-tutorial

www.elegoo.com
Elegoo
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✴Miglioramento istruzioni rispetto  
all’altra versione


✴Codice commentato molto bene,  
con la spiegazione dei comandi


✴Non ha un riscontro visivo dei componenti,  
più scomodo per un pubblico non esperto


✴Non fornisce esempi di applicazioni pratiche  
o varianti di progetto



DF Robot
https://www.dfrobot.com

58€ (RS components)


Manuale in inglese


https://github.com/


DFRobot/Beginner-Kit-for-Arduino

https://github.com/


01www.dfrobot.com 09. Light Sensitive LED

Light Sensitive LED
Let’s introduce a new sensor component: the photo diode. In simple terms, when the sensor detects light, its 

resistance changes. The stronger light in the surrounding environment, the lower the resistance value the pho-

to diode will read. By reading the photo diode’s resistance value, we can work out the ambient lighting in an 

environment. The photo diode provided in the starter kit is a typical light sensor.

In this project, we will make an automatic light that can adjust itself according to the ambient lighting around it.

When it is dark, the photo diode detects the change and triggers the light, and vice versa. 

Components 

DFRduino
UNO v3.0[R3]

DFROBOT

a
050 x1 x1

x15MM LED x1Ambient Light
Sensorx5M/M 

Jumper Cables

DFRduino UNO R3 Prototype Shield

Resistor 220R Resistor 10K

Circuit

02www.dfrobot.com 09. Light Sensitive LED

1
7 6 5 4 3 2 1 0Aref Gnd 13 12 11 10 9 8

2323 3 1

1414

2

0 1 2 3 4 5RST 3V 5V GND VIN

5V
G
ND

1

Diagram of the photo diode circuit

Be aware that photo diodes are polarized, just like LEDs, so they will only work if connected the correct 
way around.

The photo diode has to be connected with a 10k resistor rather than a ���Ʋ resistor.

  





✴Se si possiede il kit con lo shield originale,  
si seguono più facilmente gli schemi


✴La mini breadboard rende difficoltoso il montaggio

✴Elenco dei componenti chiaro,  

con riferimento visivo

✴Codice commentato bene

✴Spiegazione schematica del funzionamento  

dei componenti

✴Proposte di modifiche di progetto  

(compiti per casa)



Sparkfun
https://www.sparkfun.com

83€ (amazon)


Manuale in inglese


https://cdn.sparkfun.com/datasheets/Kits/RedBoard_SIK_3.2.pdf (old)


https://learn.sparkfun.com/tutorials/sparkfun-inventors-kit-experiment-guide---v41 (new)


https://cdn.sparkfun.com/datasheets/Kits/RedBoard_SIK_3.2.pdf
https://learn.sparkfun.com/tutorials/sparkfun-inventors-kit-experiment-guide---v41


SparkFun
Inventor’s Kit
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1 4  :  C I R CU I T  1 A

DIGITAL OUTPUT: When working with 

microcontrollers such as the RedBoard, there 

are a variety of pins to which you can connect 

electronic components. Knowing which pins 

perform which functions is important when 

building your circuit. In this circuit, we will be 

using what is known as a digital output. There 

are 14 of these pins found on the RedBoard. 

A digital output only has two states: ON or 

OFF. These two states can also be thought of 

as HIGH or LOW, TRUE or FALSE. When an LED is connected to one of these pins, the pin 

can only perform two jobs: turning on the LED and turning off the LED. We’ll explore the 

other pins and their functions in later circuits.

P O L A R I Z E D 
C O M P O N E N T S
Pay close attention to the LED. !e 
negative side of the LED is the short leg, 
marked with a "at edge.

FL AT  EDGE

SHORT  LEG

– +

R E S I S T O R 
L E A D S
Components like resistors need to have 
their legs bent into 90° angles in order to 
correctly #t in the breadboard sockets.

NEW IDEAS
ELECTRICAL SAFETY: Never work on your circuits while the board is connected to 

a power source. The SparkFun RedBoard operates at 5 volts, which, while not enough to 

injure you, is enough to damage the components in your circuit.

COMPONENT ORIENTATION & POLARITY: Instructions on how to orient each of 

the new components will be given before each circuit diagram. Many components have 

polarity and have only one correct orientation, while others are nonpolarized.
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HOOKUP GUIDE
READY TO START HOOKING EVERYTHING UP?  Check out the circuit diagram and 
hookup table below to see how everything is connected.

1 5  :  C I R CU I T  1 A 

CO N N E C T I O N  T Y P E S
 

  REDBOARD CONNECTION  BREADBOARD CONNECTION  

J U M P E R  W I R E S  D13 to J2    GND to E1  

L E D A1(-) to A2(+)

330Ω  R E S I S TO R 
( O R A N G E ,  O R A N G E , 

B R O W N )
E2 to  F2

 D13  to  J2 

In this table, a yellow 
highlight indicates that a 
component has polarity 
and will only function if 
properly oriented.

CIRCUIT DIAGRAMS: Each circuit contains a circuit diagram, which 
acts as a visual aid designed to make it easier for you to see how your circuit 
should be built. Each colored line represents a jumper wire connection in the 
circuit. All wires should have two connection points, which you also see in the 
hookup table below.  
COLORS: Please note that while traditionally red is used for power and 
black is used for ground, all wires, no matter their color, function the same. 

HOOKUP TABLES:  Many electronics beginners !nd 
it helpful to have a coordinate system when building their 
circuits. For each circuit, you’ll !nd a hookup table that 
lists the coordinates of each component or wire and where 
it connects to the RedBoard, the breadboard, or both. "e 
breadboard has a letter/number coordinate system, just 
like the game Battleship.

…means one end of a 
component connects 
to digital pin 13 on 
your RedBoard and 
the other connects to 
J2 on the breadboard

FL AT  EDGE



Circuit 2 Arduino Code:1

Troubleshooting:

LED Not Lighting Up?
LEDs will only work in one direction. Try taking it out and 
twisting it 180 degrees (no need to worry, installing it 
backward does no permanent harm).

Program Not Uploading 
!is happens sometimes, the most likely cause is a confused 
serial port, you can change this in tools>serial port>

Still No Success?
A broken circuit is no fun, send us an e-mail and we will get 
back to you as soon as we can: techsupport@sparkfun.com

You should see your LED blink on and o". If 
it isn't, make sure you have assembled the 
circuit correctly and veri#ed and uploaded the 
code to your board or see the troubleshooting 
tips below. 

Before you can use one of the RedBoard's pins, you need to tell the 
RedBoard whether it is an INPUT or OUTPUT. We use a built-in 
"function" called pinMode() to do this.

When you're using a pin as an OUTPUT, you can command it to be 
HIGH (output 5 volts), or LOW (output 0 volts).

digitalWrite(13, HIGH);

pinMode(13, OUTPUT);

Code to Note:

Real World Application:

Almost all modern $at screen televisions and monitors 
have LED indicator lights to show they are on or o".

Open Arduino IDE // File > Examples > SIK Guide > Circuit # 1

What you Should See:

This is where you will find the 
Arduino code for each circuit.

Remember to Verify and 
Upload your code.

See if your circuit is complete 
and working in this section.

Begin to understand how the 
Arduino code works. See below.
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LEARN. SHARE. HACK.

This is a section dedicated to the most 
common mistakes made while assembling 
the circuit. 

Here you will find examples of the circuit 
you just completed in the real world. 
Many of the theories in these circuits are 
used in things you use everyday!
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ONBOARD LED PIN 13 : 
You may have noticed a second, 
smaller LED blinking in unison 
with the LED in your breadboard 
circuit. !is is known as the 
onboard LED, and you can "nd 
one on almost any Arduino or 
Arduino-compatible board. In 
most cases, this LED is connected 
to digital pin 13 (D13), the 
same pin used in this circuit.

CODE TO NOTE

SETUP AND LOOP:

void setup(){} &  
void loop(){}

Every Arduino program needs these two functions. Code that goes in 
between the curly brackets {} of setup()runs once.  !e code in 
between the loop()curly brackets {} runs over and over until the 
RedBoard is reset or powered o#.

INPUT OR OUTPUT?:

 pinMode(13, OUTPUT);

Before you can use one of the digital pins, you need to tell the RedBoard 
whether it is an INPUT or OUTPUT. We use a built-in “function” called 
pinMode() to make pin 13 a digital output. You’ll learn more about 
digital inputs in Project 2.

PROGRAM OVERVIEW
1 Turn the LED on by sending power (5V) to digital pin 13.

2 Wait 2 seconds (2000 milliseconds).

3 Turn the LED off by cutting power (0V) to digital pin 13.

4 Wait 2 seconds (2000 milliseconds). 

5 Repeat.

NEW IDEAS
CODE TO NOTE: !e sketches that accompany each circuit introduce new programming techniques and 
concepts as you progress through the guide. !e Code to Note section highlights speci"c lines of code from the 
sketch and explains them in greater detail.
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HOOKUP GUIDE
READY TO START HOOKING EVERYTHING UP? Check out the circuit diagram and 

hookup table below to see how everything is connected.

FL AT  EDGE

2 7  :  C I R CU I T  1 C 

CO N N E C T I O N  T Y P E S
 

  REDBOARD CONNECTION  BREADBOARD CONNECTION  

J U M P E R  W I R E S

  5V to 5V(+)
 

  GND to GND (-)
  

 D13 to J2
 

 A0 to E26
 

E1 to GND(-)
   

E25 to 5V(+)
 

E27 to GND(-)
 

L E D A1(-) to A2(+)

330Ω  R E S I S TO R 
( O R A N G E ,  O R A N G E ,  

B R OW N )
E2 to  G2 

 

10KΩ  R E S I S TO R 
( B R OW N ,  B L AC K ,  

O R A N G E )
B26 to  C27

P H OTO R E S I S TO R A26 to  B25  

NEW IDEAS
PHOTORESISTORS: The 

photoresistors, like regular resistors, 

are not polarized and can be installed in 

either direction.





Code
https://github.com/sparkfun/SIK-Guide-Code



✴Troubleshooting

✴Applicazioni dei progetti nella vita reale 

✴Molto chiaro e meticoloso

✴Codice richiamabile già all’interno dell’IDE  

di Arduino tramite libreria

✴Elenco dei componenti visivo e testuale

✴Le schede sono impaginate in modo da essere 

seguite facilmente durante il montaggio



Oomlout
http://oomlout.com

Non più disponibile il kit


Versione ripresa ed estesa della Adafruit 85$ (MetroX)


https://learn.adafruit.com/experimenters-guide-for-metro


Manuale in inglese


http://ardx.org/src/guide/2/ARDX-EG-OOML-WEB.pdf


http://ardx.org/src/


https://learn.adafruit.com/experimenters-guide-for-metro
http://ardx.org/src/guide/2/ARDX-EG-OOML-WEB.pdf
http://ardx.org/src/


Arduino 
pin 13

LED
(light emitting diode)

resistor (560ohm)
(green-blue-brown)

gnd
(ground) (-)

08

CIRC-01

WHAT WE’RE DOING:

.:Getting Started:.
.:(Blinking LED):.

LEDs (light emitting diodes) are used in all sorts of clever things 
which is why we have included them in this kit. We will start off 
with something very simple, turning one on and off, repeatedly, 
producing a pleasant blinking effect. To get started, grab the parts 
listed below, pin the layout sheet to your breadboard and then plug 
everything in. Once the circuit is assembled you'll need to upload the program. To do this plug the 
Arduino board into your USB port. Then select the proper port in Tools > Serial Port > (the 
comm port of your Arduino). Next upload the program by going to File > Upload to I/O 
Board  (ctrl+U). Finally, bask in the glory and possibility that controlling lights offers.

If you are having trouble uploading, a full trouble shooting guide can be found here: http://ardx.org/TRBL

Wire 
10mm LED
x1

560 Ohm Resistor
Green-Blue-Brown
x1

2 Pin Header
x4

CIRC-01 
Breadboard Sheet
x1

Parts:

.:download:.
breadboard layout sheet

http://ardx.org/BBLS01
.:view:.

assembly video
http://ardx.org/VIDE01

The Internet

longer lead
+

THE CIRCUIT:

Schematic

Note: Breadboard dimensions vary 
between manufacturers so some 
adjustments may be necessary.
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to 
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CIRC-01
Getting Started Large 

Blinking LED

+
-

a
c

10mm
LED

longer
lead

CIRC-01
Getting Started
(Blinking LED)

http://ardx.org/CIRC01



NOT WORKING? (3 things to try)

CODE (no need to type everything in just click)

09

CIRC-01
File >  1.Basic > Blink
(example from the great arduino.cc site, check it out for other ideas)

 Examples >

/* Blink
 * Turns on an LED on for one second, then off for one second,
 * repeatedly.
 * Created 1 June 2005 By David Cuartielles
 * http://arduino.cc/en/Tutorial/Blink
 * based on an orginal by H. Barragan for the Wiring i/o board
 */

int ledPin =  13;    // LED connected to digital pin 13

// The setup() method runs once, when the sketch starts
void setup()   {                  // initialize the digital pin as an output:
  pinMode(ledPin, OUTPUT);     }

// the loop() method runs over and over again,
// as long as the Arduino has power
void loop()                     {
  digitalWrite(ledPin, HIGH);   // set the LED on
  delay(1000);                  // wait for a second
  digitalWrite(ledPin, LOW);    // set the LED off
  delay(1000);                  // wait for a second
}

More details, where to buy more parts, where to ask more questions:

http://ardx.org/CIRC01

LED Not Lighting Up?
LEDs will only work in one 

direction. Try taking it out and 
twisting it 180 degrees.

(no need to worry, installing it 
backwards does no permanent 

harm).

Changing the pin: Control the brightness:
The LED is connected to pin 13 but we can use any of Along with digital (on/off) control the Arduino can control 
the Arduino’s pins. To change it take the wire plugged some pins in an analog (brightness) fashion. (more details on 
into pin 13 and move it to a pin of your choice (from 0- this in later circuits). To play around with it.
13) (you can also use analog 0-5, analog 0 is 14...) Change the LED to pin 9: (also change the wire)

ledPin = 13; -> int ledPin = 9;Then in the code change the line:
 int ledPin = 13; -> int ledPin = newpin; Replace the code inside the { }'s of loop() with this:

analogWrite(ledPin, new number);Then upload the sketch: (ctrl-u)
Change the blink time: (new number) = any number between 0 and 255.
Unhappy with one second on one second off?  0 = off, 255 = on, in between = different brightness

Fading:In the code change the lines:
  digitalWrite(ledPin, HIGH);  We will use another included example program. To open go to
 delay(time on);  //(seconds * 1000) File > Examples > 3.Analog > Fading
 digitalWrite(ledPin, LOW);

Then upload to your board and watch as the LED fades in and  delay(time off); //(seconds * 1000)
then out.

Still No Success?
A broken circuit is no fun, send 

us an e-mail and we will get 
back to you as soon as we can.

help@oomlout.com

Program Not Uploading 
 This happens sometimes, 
the most likely cause is a 
confused serial port, you 

can change this in 
tools>serial port>

MAKING IT BETTER

MORE, MORE, MORE:

05

03 PROG
programming 

primer

MATHS OPERATORS
= (assignment)  makes something equal to something else (eg. x 

= 10 * 2 (x now equals 20))
% (modulo)  gives the remainder when one number is divided by 

another (ex. 12 % 10 (gives 2))
+   (addition)
- (subtraction)
* (multiplication)
/ (division)

Operators used for 
manipulating numbers. 
(they work like simple 
maths).

COMPARISON OPERATORS

== (equal to) (eg. 12 == 10 is FALSE or 12 == 12 is TRUE)
!= (not equal to) (eg. 12 != 10 is TRUE or 12 != 12 is FALSE)
< (less than) (eg. 12 < 10 is FALSE or 12 < 12 is FALSE or 12 < 14 is TRUE)
> (greater than) (eg. 12 > 10 is TRUE or 12 > 12 is FALSE or 12 > 14 is 

FALSE)

Operators used for 
logical comparison.

CONTROL STRUCTURE
if(condition){ }
else if( condition ){ }
else { }
This will execute the code between 
the curly brackets if the condition 
is true, and if not it will test the 
else if condition if that is also 
false the else code will execute.

Programs are reliant on 
controlling what runs 
next, here are the basic 
control elements (there 
are many more online).

for(int i = 0; i < 
#repeats; i++){   }

Used when you would like to 
repeat a chunk of code a number 
of times (can count up i++ or 
down i-- or use any variable)

DIGITAL
digitalWrite(pin, value);

Once a pin is set as an OUTPUT, 
it can be set either HIGH (pulled 
to +5 volts) or LOW (pulled to 
ground).

pinMode(pin, mode);
Used to set a pin's mode, pin 
is the pin number you would 
like to address 0-19 (analog 0-
5 are 14-19). The mode can 
either be INPUT or OUTPUT.

int digitalRead(pin); 

Once a pin is set as an INPUT 
you can use this to return 
whether it is HIGH (pulled to 
+5 volts) or LOW (pulled to 
ground).

ANALOG
int analogWrite(pin, 
                value);
Some of the Arduino's pins support 
pulse width modulation (3, 5, 6, 9, 10, 
11). This turns the pin on and off very 
quickly making it act like an analog 
output. The value is any number 
between 0 (0% duty cycle ~0v) and 
255 (100% duty cycle ~5 volts).

The Arduino is a digital 
machine but it has the ability 
to operate in the analog 
realm (through tricks). 
Here's how to deal with 
things that aren't digital.

int analogRead(pin);

When the analog input pins are set 
to input you can read their voltage. 
A value between 0 (for 0 
volts) and 1024 (for 
5 volts) will be 
returned.

.:For a full programming reference visit:.
http://ardx.org/PROG



✴ Introduzione al progetto

✴Troubleshooting

✴Proposte di modifiche sia al codice che al circuito 

(con spiegazione)

✴Schema del circuito con elenco visivo componenti 

✴Pochissimo commento al codice

✴Alcuni codici sono quelli del kit di Arduino



Earthshine Design
Non più disponibile


Manuale in inglese


https://ia800603.us.archive.org/15/items/ArduinoStarterKitManual/
Arduino_Beginners_Manual.pdf
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Project 6 - Interactive LED Chase Effect
We are now going to use a string of LEDʼs (10 in total) 
to make an LED chase effect, similar to that used on 
the car KITT in the Knightrider TV Series and on the 
way introduce the concept of arrays.

What you will need

Parts from previous 
project plus....

4K7 Potentiometer

Connect it up

This is the same circuit as in Project 5, but we have 
simply added the potentiometer and connected it to 
5v, Ground and Analog Pin 5.

Enter the code

This time when verify and upload your code, you 
should now see the lit LED appear to bounce back 
and forth between each end of the string of lights as 
before. But, by turning the knob of the potentiometer, 
you will change the value of ledDelay and speed up 
or slow down the effect.

Letʼs take a look at how this works and find our what a 
potentiometer is.

// Create array for LED pins
byte ledPin[] = {4, 5, 6, 7, 8, 9, 10, 
11, 12, 13};
int ledDelay; // delay between changes
int direction = 1;
int currentLED = 0;
unsigned long changeTime;
int potPin = 2;    // select the input 
pin for the potentiometer

void setup() {
  // set all pins to output
  for (int x=0; x<10; x++) {
    pinMode(ledPin[x], OUTPUT); }
    changeTime = millis();
}

void loop() {
// read the value from the pot 
ledDelay = analogRead(potPin);    
  // if it has been ledDelay ms since 
last change
  if ((millis() - changeTime) > 
ledDelay) {
    changeLED();
    changeTime = millis();
  }
}

void changeLED() {
  // turn off all LED's
  for (int x=0; x<10; x++) {
    digitalWrite(ledPin[x], LOW);
  }
  // turn on the current LED
  digitalWrite(ledPin[currentLED], 
HIGH);
  // increment by the direction value
  currentLED += direction;
  // change direction if we reach the 
end
  if (currentLED == 9) {direction = 
-1;}
  if (currentLED == 0) {direction = 1;}
}

Earthshine Design Arduino Starters Kit Manual - A Complete Beginners Guide to the Arduino
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Project 6 - Code Overview

// Create array for LED pins
byte ledPin[] = {4, 5, 6, 7, 8, 9, 10, 11, 
12, 13};
int ledDelay; // delay between changes
int direction = 1;
int currentLED = 0;
unsigned long changeTime;
int potPin = 2;    // select the input pin 
for the potentiometer

void setup() {
  // set all pins to output
  for (int x=0; x<10; x++) {
    pinMode(ledPin[x], OUTPUT); }
    changeTime = millis();
}

void loop() {
// read the value from the pot  
ledDelay = analogRead(potPin);    
  // if it has been ledDelay ms since last 
change
  if ((millis() - changeTime) > ledDelay) {
    changeLED();
    changeTime = millis();
  }
}

void changeLED() {
  // turn off all LED's
  for (int x=0; x<10; x++) {
    digitalWrite(ledPin[x], LOW);
  }
  // turn on the current LED
  digitalWrite(ledPin[currentLED], HIGH);
  // increment by the direction value
  currentLED += direction;
  // change direction if we reach the end
  if (currentLED == 9) {direction = -1;}
  if (currentLED == 0) {direction = 1;}
}

The code for this Project is almost identical to the 
previous project. We have simply added a 
potentiometer to our hardware and the code has 
additions to enable us to read the values from the 
potentiometer and use them to adjust the speed of the 
LED chase effect.

We first declare a variable for the potentiometer pin

int potPin = 2;  

as our potentiometer is connected to analog pin 2. To 
read the value from an analog pin we use the 
analogRead command. The Arduino has 6 analog 
input/outputs with a 10-bit analog to digital convertor 
(we will discuss bits later on). This means the analog 
pin can read in voltages between 0 to 5 volts in integer 
values between 0 (0 volts) and 1023 (5 volts). This 
gives a resolution of 5 volts / 1024 units or 0.0049 
volts (4.9mV) per unit. 

We need set our delay using the potentiometer so we 
will simply use the direct values read in from the pin to 
adjust the delay between 0 and 1023 milliseconds. We  
do this be directly reading the value of the 
potentiometer pin into ledDelay. Notice that we do not 
need to set an analog pin to be an input or output like 
we need to with a digital pin. 

ledDelay = analogRead(potPin); 

This is done during our main loop  and therefore it is 
constantly being read and adjusted. By turning the 
knob  you can adjust the delay value between 0 and 
1023 milliseconds (or just over a second) and 
therefore have full control over the speed of the effect.

OK letʼs find out what a potentiometer is and how it 
works.
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Project 6 - Hardware Overview
The only additional piece of hardware used in this 
project was the 4K7 (4700Ω) 
potentiometer.

You have a l ready come 
across a resistor and know 
h o w t h e y w o r k . T h e 
potentiometer is simply an 
adjustable resistor with a range 
from 0 to a set value (written on 
the side of the pot). In the kit you 
have been given a 4K7 or 4,700Ω potentiometer which 
means itʼs range is from 0 to 4700 Ohms.

The potentiometer has 3 legs. By connecting up  just 
two legs the potentiometer becomes a variable 

resistor. By connecting all 3 legs and applying a 
voltage across it, the pot becomes a voltage divider. 
This is how we have used it in our circuit. One side is 
connected to ground, the other to 5v and the centre 
pin to our analog pin. By adjusting the knob, a voltage 
between 0 and 5v will be leaked from the centre pin 
and we can read the value of that voltage on Analog 
Pin 2 and use itʼs value to change the delay rate of the 
light effect.

The potentiometer can be very useful in providing a 
means of adjusting a value from 0 to a set amount, 
e.g. the volume of a radio or the brightness of a lamp. 
In fact, dimmer switches for your home lamps are a 
kind of potentiometer.

Exercises

1. Get the LEDʼs at BOTH ends of the strip  to start as on, then to both move towards each other, appear to bounce off each other and then move back to the end.
2. Make a bouncing ball effect by making the LED start at one end, ʻdropʼ toward the other end, bounce back up, but to only go up  9 spaces, bounce, go up  8 spaces, then 7, then 6, etc. To give the effect it is a bouncing ball, getting bouncing up  to a lower height on each bounce.



✴Elenco visivo componenti con overview contenuti e 
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✴Non contiene lo schema del circuito

✴Esercizi e spunti per modificare il codice





NOW!



NOW!
Se non ho voglia di aspettare il corriere



Tool online
https://create.arduino.cc/



Tool online
https://www.tinkercad.com



Tool online
https://www.tinkercad.com



Tool online
https://www.tinkercad.com



Tool online
https://www.circuito.io/
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Forum



Forum



Cat feeder

http://www.damonkohler.com

Tweet-a-Pot

http://www.instructables.com/

Botanicalls

http://www.botanicalls.com

LED Matrix lamp with hot glue

https://www.thingiverse.com/thing:3403301



Che ne faccio?

nootropicdesign.com/projectlab/2011/ 
09/05/defusable-clock/


http://www.instructables.com/id/Led-Cube-8x8x8

http://www.instructables.com/id/
Pressure-Activated-Light-Up-Umbrella/

www.graysonearle.com/frogutopia/

http://www.instructables.com/id/


Che ne faccio?

nootropicdesign.com/projectlab/2011/ 
09/05/defusable-clock/


http://www.instructables.com/id/Led-Cube-8x8x8

http://www.instructables.com/id/
Pressure-Activated-Light-Up-Umbrella/

www.graysonearle.com/frogutopia/

http://www.instructables.com/id/


www.instructables.com/id/3D-Printed-Quadcopter

http://www.instructables.com/id/FuzzBot/ http://tinkerlog.com/2011/09/02/der-kritzler/

http://www.thingiverse.com/thing:248009



www.instructables.com/id/3D-Printed-Quadcopter

http://www.instructables.com/id/FuzzBot/ http://tinkerlog.com/2011/09/02/der-kritzler/

http://www.thingiverse.com/thing:248009
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